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快速启动指南
一本适合 PM5D 的实际使用人员的指南。

/

第 3 部分
介绍 Studio Manager 和 PM5DV2 Editor。
显示设置流程指南。

本“快速启动指南”系列是专为首次使用雅马哈 PM5D
的人员编写的。这不是一本音频混合指南，它假定读者

已具备模拟调音台经验。本指南并未涵盖 PM5D 使用的

所有特点和方法，它不能代替用户手册；如需更多信息，

建议参考用户手册。
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PM5D/PM5D-RH 快速启动指南分为三个部分。

第 1 部分（简介和设置流程指南）；

1) 概述 PM5D 连接、表面布局和主要混音功能。

2) 简要说明储存 / 调用和保存 / 加载过程。

3) 乐队技师如何设置调音台进行特定表演的流程示例。流程深入到创建表演的第一个场景。

设置流程指南包括：

1) 输入命名和转接

2) 幻象设置

3) 输出命名和转接

4) 效果转接

5) 矩阵命名和转接

6) GEQ 转接

7) 用户自定义键编程

8) 可分配衰减器分配设置

9) 监听衰减器（如果需要）

10) 将所有这些储存为开始场景

362页的说明书外加编辑器和驱动程序指南。嗯...应该有更

快的方法...

第 2 部分（储存编辑和保存）；

1) 使用 PREVIEW 模式、Global Paste 和 Tracking Recall 储存并编辑已储存的场景。

2) 调用场景并通过 Recall Safe 或 Selective Recall 功能限制调用。

3) 用 PCMCIA 卡进行保存和加载；如何保存个别资料库或场景并将它们加载至其他调音台，而不在接收调音

台上丢失音频或数据。

第 3 部分 介绍 Studio Manager 和 PM5DV2 Editor；

本指南介绍 Studio Manager 和 PM5DV2 Editor。分为三个部分。

1)   如何通过脱机工作的 Studio Manager 软件实现第 1 部分和第 2 部分中所涵盖的设置和操作。

2)   如何与 PM5D 进行联机以及对调音台进行远程控制和监听。

3)   如何使用 PM5DV2 Editor 将场景载入 PM5D 而不使用 PCMCIA 卡或停止演出。
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Studio Manager 的背景和简介。

PM5D并不特别针对任何类型的演播室活动；它主要是一部实况音乐会转播调音台，因此许多人因其远程控制

和编辑软件的Studio Manager名称而产生误解。事实上，Studio Manager和PM5DV2编辑器非常适用于实况声音

技师的需求；可在远离调音台的PC或Mac上打开PM5D文件并进行编辑、保存和复制。文件都很小可通过电子

邮件发送，还可将不同演出的场景合并创建新的文件， 并且可在任意两个场景之间进行无缝切换。

Studio Manager这一名称来源于该软件更广泛的应用能力——可与演播室环境中的许多其他数字音频产品结合

使用。Studio Manager不仅仅限于远程控制一台PM5D，还能远程控制多台PM5D、其他雅马哈数字调音台、

SPX2000效果器和Motif键盘。反过来，Studio Manager可以成为Steinberg Cubase SX3 DAW设置的一部分，可在

用DAW打开的单个文件中保存这些产品的所有设置。

当然，其广泛的功能性与对PM5D进行简单的远程控制和编辑无关，但现在了解一些背景知

识很有必要，以便今后理解如何保存PM5D和DSP5D的联合设置文件，或在主副混合配置下

使用多部调音台的设置文件。

Studio Manager

SPX2000

DM2000

MOTIF ES6/7/8

MOTIF ES6/7/8 Multi Part Editor

DM2000 Editor

SPX2000 Editor

Studio Manager

Studio Manager

DAW
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Studio Manager 和 PM5DV2 Editor 的作用是什么？

Studio Manager 和 PM5DV2 Editor 的结合软件能使您在个人计算机上创建和编辑 .PM5 文件。这些文件可保存某

一设置中所有场景的全部参数数据，并且可使用 PCMCIA 数据卡传送至调音台。亦可通过 USB MIDI 驱动程序

或 USB 电缆连接，在“联机”模式下使用 Studio Manager 和 PM5D Editor 对 PM5D 调音台进行远程控制和监听，

或在计算机和调音台存储器之间直接交换数据。

同样，带 DSP5D Editor 的相同 Studio Manager 可创建和编辑载入 DSP5D 的 .PM5 文件。在这种情况下，通过网

络端口建立连接而所需的驱动程序软件为雅马哈 DME-N Network 驱动程序。Studio Manager 和 DSP5D 编辑器

是迄今从 DSP5D 加载和保存数据的最有效方法。

PM5D 并非必须配合 Studio Manager 使用；调音台无需任何外部计算机设备就能提供其所有功能，但 Studio 
Manager 增加了非常有用的额外访问途径。您无需访问调音台就能在 PC 上完成命名通道、转接 I/O、设置效

果装置和参数等准备事宜；不管是在家里还是在公共汽车上，甚至在飞机上。其次，在连接 PM5D 时 Studio 
Manager 可提供另一种界面，给出带有额外控制界面的不同视图，可供两名操作员使用并可使用平板 PC 进行

远程控制甚至无线控制。

从哪里可以获得 Studio Manager ？
可从以下网址免费下载 Studio Manager 和各种编辑器程序；;
 www.yamahaproaudio.com 
从 DOWNLOADS 页面找到 FIRMWARE AND SOFTWARE。

应该为 PM5D 下载三个软件；

1. Studio Manager V2 Host（Windows 和 Mac OS 版本均有）

2. PM5DV2 Editor（Windows 和 Mac OS 版本均有）

3. USB-MIDI Driver（各种 Windows 和 Mac OS 版本均有）

对于 DSP5D 控制，另外需要 DSP5D Editor 和 DME-N Network 驱动程序。

从 www.yamahaproaudio.com 下载的都是最新的版本且相互兼容并兼容最新的调音台固件。旧版本的 Studio 

Manager 可能无法与最新的调音台版本通信，所以最好从网上下载而不要依赖随调音台附带或租借的 CD。因软

件持续开发而导致的任何额外限制均会在网站上进行说明。

目前可免费下载 Studio Manager 软件，但请牢记需要勾选“Licence Agreement”（许可协议）且您只能在协议条

款和条件允许的范围内使用该软件。
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对于 Mac OSX（目前没有 Mac 版的 DSP5D 编辑器）
CPU：PowerPC G4 或更高

操作系统：MacOS X 10.4-10.5
硬盘：30 MB 或以上

内存：512MB 或以上

显示器：1,024 x 768 像素或以上，高色彩 16 位或更高

其他：USB 端口 (PM5D)

如果您想在 Intel Mac 上使用 Mac 版的 PM5D Editor，则 Editor 仅会在 Rosetta 下工作。

需要什么类型的计算机？

系统要求会因未来更新而改变，在网站的下载页面上会给出当前信息，但在 2008 年秋季为；

对于 Windows Vista
CPU：1.4GHz 或以上的 Intel Core/Pentium/Celeron 系列处理器

操作系统：Windows Vista（32 位；Ultimate/Enterprise/Business/Home Premium/Home Basic）
硬盘：30 MB 或以上

内存：1GB 或以上

显示器：1,024 x 768 像素或以上，高色彩 16 位或更高

其他：USB 端口 (PM5D) 网络端口 (DSP5D)

对于 Windows XP 
CPU：1 GHz 或以上的 Intel Core/Pentium/Celeron 系列处理器

操作系统：Windows XP Professional / XP Home Edition /
 XP Tablet PC Edition 2005 
硬盘：30 MB 或以上

内存：512 MB 或以上

显示器：1,024 x 768 像素或以上，高色彩 16 位或更高

其他：USB 端口 (PM5D) 网络端口 (DSP5D)
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安装软件。
可从下载页面下载完整的软件安装说明。安装向导会在整个安装过程中给您指导。除非您对安装目的地有特殊

要求，否则请使用默认设置。

如果没有 PM5D 的使用权，还能启动和使用软件吗？
能。一旦正确安装了Studio Manager软件，即可将它打开而无需调音台。但应明白PM5DV2 Editor图形与调音台

中的不同，因而研究PM5DV2 Editor并非了解实际调音台如何显示和工作的有效方法。没有PM5D就无法打开

USB-MIDI Driver，但这仅在连接PM5D进行通信时才需要。

应该使用哪个软件版本？

雅马哈在不断开发PM5D混音系统，有时会发布包含

新功能的新版本而有时新版本只是调整现有系统以改

进性能和“错误修正”。当发布新的调音台版本时，

通常需要新的Studio Manager和Editor版本以保持兼容

性。

调音台中保存的所有文件均为.PM5类型的文件且可在

所有未来调音台版本中打开，但是无法保证未来的文

件仍会与旧的调音台兼容。为此，雅马哈强烈建议在

所有调音台中使用当前的调音台固件。如果您拥有调

音台，请使其保持最新固件，否则来访技师可能无法

打开他们的文件。如果您是一位巡回自由技师，请携

带最新的固件和升级用PCMCIA或CF卡。调音台固件

在www.yamahaproaudio.com上免费提供

用Studio Manager保存的文件可具有其他格式（请参阅

本指南的第15/16页）。如果用V1版的Studio Man-
ager将文件保存为.YSM或.YSE文件，则无法在V2版中

打开。

雅马哈始终建议使用最新的调音台固件版本以及最新版本的Studio Manager和PM5DV2 Editor。该组合兼容联机

连接和同步，将具有最新的功能和最少的已知软件错误问题。但是，我们明白实际使用中旧的调音台版本仍在

流行，技师们可能已在旧的SM和Editor版本中保存数据。

该如何处理旧的版本？

此表是2008年12月的示例；
请从www.yamahaproaudio.com获取最新信息

为确保所有文件均可使用，www.yamahaproaudio.com的下载页面上有两个PC版和两个Mac版的Studio Manager 
PM5D Editor。这些涉及到以前的V1和最新的V2版PM5D调音台固件。如果您现在拥有保存为.YSM或.YSE型
文件的V1 Editor文件，则需要使用V1版本的固件。然后您可将这些文件重新保存为.PM5文件，即可载入任意

版本的调音台。如果调音台为V2版，则新保存的文件将更新至V2版，您可继续使用V2版的Studio Manager和
Editor。

像任何其他程序一样打开 Studio Manager；
 点击“开始”..............
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PM5DV2V2
DSP5DDSP5D

程序打开时，从File菜单选择Setup参数。使PM5DV2 
Editor高亮显示并点击[Add->]将其移至工作区。按需

要对DSP5D重复此操作。

当编辑器处于工作区时，应选中[Set Default]框，这样

无需在下次打开Studio Manager时进行此操作。

点击[OK]按钮，Studio Manager窗口会显示所选的编

辑器。

双击编辑器图标打开编辑器。

（如果您拥有多台调音台的复杂设置，您可左键双击

图标下面的名称逐个命名。）

窗口大小可以调整，但内容无法缩放。

如果您的屏幕不够大，则必须使用滚动条。

对于类似INPUT CH 1-24的窗口，View标签会非常有

用。您可从显示屏中删除不使用的窗口部分，例如，

如果您不使用输入延迟或所有的混音发送，则可将它

隐藏起来从而获得较小的窗口。这样无需滚动就能看

到整个窗口，并且有空间同时打开其他窗口。

Editor打开时会显示INPUT CH 1-24窗口。  

首次打开 Studio Manager 和 Editor。

使用 Editor 窗口

首次打开Studio Manager时需要完成一些设置事宜。
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使用Window标签按需要打开其他窗口。屏幕

的分辨率越高，可安排的窗口就越多。

更改参数

使用您的计算机鼠标设置Editor窗口中显示的控制钮。

例如；

点击并上下拖动衰减器。

点击打开或关闭按钮。

点击并顺时针或逆时针拖转旋钮。

双击dB数字值并输入数值。

双击名称（如Ch14）并重命名通道。（仍限于四个字

符）。

可点击并上下拖动混音发送值或点击混音编号将其打

开/关闭，但这种方法无法提供非常精细的控制，同样

也可以点击并拖动EQ曲线，但难以进行精确调整。

请使用SEL通道窗口进行精细控制。通过菜单条或双

击混音条上方的通道编号打开SEL通道窗口。
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SEL通道窗口；

主视图和附加视图

PM5DV2 Editor有两个SEL通道窗口；主视图和附加视

图。两个视图看起来相同，可同时显示在屏幕上，不

同之处在于如何选择所显示的通道。

还需注意，主视图可通过窗口内的按钮访问资料库，

但这些按钮在附加视图中无法选择。

主视图通过[SEL]按钮来选择，而附加视图则通过使用

箭头增加和减少通道来选择，或点击[Select]条从所产

生的包括所有通道的下拉框中进行选择。

目前，无论使用哪条SEL通道，主视图可能会更加方

便，且具备资料库快捷方式，但以后联机连接调音台

时，您可能要决定需要Studio Manager显示与调音台相

同的SEL通道还是不同的SEL通道。

拖转旋钮。

若要设置旋钮的值，请点击并拖转旋钮。旋钮会像模

拟旋钮一样达到旋转终点。为获得更高精度，可点击

旋钮并沿圆半径拖出指针，然后犹如转动具有该半径

的大旋钮一样转动旋钮。这在使用平板控制时尤其有

用。亦可在旋钮上方的文本框中输入数值。
拖出，然
后转动

通道复制和粘贴
可将 SEL 通道轻松复制并粘贴至新选择的通道。可
使用 Edit 菜单或 Windows 中常用的快捷键 Ctrl+C 和
Ctrl+V（Mac 中为 +C 和 +V）。
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MacintoshWindows

File

Ctrl+N +N

Ctrl+O +O

Ctrl+S +S

Edit

Ctrl+Z +Z

Ctrl+Y +Y

Ctrl+C +C

Ctrl+V +V

Windows

Ctrl+W +W

Ctrl+Alt+W +Option+W

Sync Ctrl+1 +1

INPUT CH (CH1-24) Ctrl+2 +2

INPUT CH (CH25-48) Ctrl+Alt+2 +Option+2

Selected Channel Ctrl+3 +3

Library Ctrl+4 +4

Patch Editor Ctrl+5 +5

Surround Editor Ctrl+6 +6

Timecode Counter Ctrl+7 +7

Effect Editor Ctrl+8 +8

Meter Ctrl+9 +9

GEQ Editor Ctrl+0 +0

DCA/Mute Group Ctrl+Alt+1 +Option+1

Scene Ctrl+Alt+3 +Option+3

Shift+

Ctrl+ +

Ctrl+A +A

Shift+Library Scene
SCENE MEMORY
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THE EXAMPLES

PLEASE DO NOT USE ANY GENETICALLY MODIFIED INGREDIENTS, AND USEORGANIC PRODUCE WHEREVER POSSIBLE.PLEASE NO BLACK PEPPER IN VEGETARIAN DISHES DUE TO ALLERGY.Crew party is 7, band party is 8 We have a number of strict vegetarians on ourtouring staff. Please ensure they are properly catered for.DRESSING ROOMS
BAND DRESSING ROOM - TO BE SET 4 hrs before show timeBEVERAGES - half to be well chilled on plenty of ice 1 TEA KETTLE ABLE TO BOIL WATER FULL ASSORTED TEA SET-UP (PLEASE INCLUDE PG TIPS AND ENGLISH BREAKFAST) 

WITH LEMONS, HONEY, RAW GINGER ROOT, CUTTING BOARD, KNIFE, AND CARROT 
PEELER 
PLATES, SILVER AND NAPKINS FOR 15 1 DOZEN RED WINE GLASSES 1 DOZEN COFFEE MUGS Fresh Cut Flower Assortment VERY IMPORTANT - your efforts in securing these wines will go a long way to ensuring fond 

memories of your show: 1 bottle of excellent quality Italian red wine - Sassicaia, Solaia or Tignanello - vintages between 88 and 91. 
1 bottle of excellent quality white wine - Corton Charlemagne preferred - between 88 and 91 
12 – 1 LITER EVIAN, OR NAYA, OR FIJI WATER 2 CASES (48) SMALL EVIAN, OR NAYA, OR FIJI 6 COKE, 6 DIET COKE, 6 7-UP 6 ASSORTED ODWALLA OR NAKED JUICE OR HANSEN SMOOTHIES 4 SMALL TWIST OFF PERRIER OR SAN PELLIGRINO 1 BOTTLE POM POMEGRANITE JUICE (PLAIN, NOT FLAVORED) 6 BLUE GATORADES, 6 RED GATORADES 6 CORONA, 6 BECKS, 6 SIERRA NEVADA PALE ALE, ALL BOTTLES 4 GUINESS PUB STYLE DRAUGHT IN CANS 1 FRESH SUSHI PLATTER (FROM A LOCAL SUSHI RESTAURANT) SHOULD INCLUDE ABOUT 20 ASSORTED PIECES INCLUDING SOME THAT ARE ALL 

VEGETARIAN (NO CRAB EITHER) 1 ANTIPASTO PLATTER – SHOULD INCLUDE AN ASSORTMENT OF OLIVES, ARTICHOKE HEARTS, STUFFED GRAPE LEAVES, CRUDITE WITH DIP, SLICED GOURMET SALAMI, ROASTED VEGGIES ETC …ETC … (BE CREATIVE) 1 GOURMET CHEESE PLATTER TO INCLUDE 2-3 DIFFERENT CHEESES, CRACKERS 
AND SEEDLESS GRAPES 1 WHOLE FRUIT BASKET 1 CUT FRESH FRUIT PLATTER 1 CONTAINER OF HUMMUS AND TRIANGLES OF WHEAT PITA BREAD AND ABOUT FIVE OR SIX SMALL BOWLS OF THINGS TO NIBBLE ON …... ASSORTED 

CHOCOLATES, ASSORTED HARD CANDIES, HEALTHY SNACKS LIKE DRIED APRICOTS, YOGURT RAISINS, MIXED NUTS, DATES ETC …ETC ….

Input Channel List for THE EXAMPLES Output Channel list for THE EXAMPLESAs; August 2006
As; August 2006

Ch Channel Mic +48V Mix Description Notes 1  KICK 1 SH 53 Mix 1 SF SR TOP + SUB  
2  KICK 2 SH 92 Y Mix 2 SF SL TOP + SUB 3  SNARE TOP SH 57 Mix 3 Bass Out Wedges 4  SNARE IN XLR Y Mix 4 Bass In Wedges 5  SNARE BOTT KP 85 Y Mix 5 GTR Out Wedges 6  TIMBALE Theta 98 Mix 6 GTR In Wedges 7  HI HAT A 452 * Y Mix 7 Drum Wedge Wedge 8  TOM 1 Theta 98 Y Mix 8 Drum Sub Dual 15 Pwr Sub  

9  TOM 2 Theta 98 Y Mix 9 Drum Rev FX 3 10  TOM 3 Theta 98 Y Mix 10 Key Wedge L Wedges 11  TOM 4 Theta 98 Y Mix 11 Key Wedge R Wedges 12  RIDE A 461 Y Mix 12 Nick Ears L Wireless IEM Plus Extra Belt pack for Keys Tech 
13  OH SR  A 415 Y Mix 13 Nick Ears R Wireless IEM Plus Spare Pack = 3 packs 
14  OH SL A 415 Y Mix 14 Drum Ears L Wired Ears Plus Spare Belt Pack = 2 packs 
15  SPD Active DI Y Mix 15 Drum Ears R Wired Ears 16  BASS PRE Active DI Y Mix 16 Simon Ears L Wireless IEM Plus Spare Belt Pack = 2 packs 
17  BASS POST UHF Theta 98 Mix 17 Simon Ears R Wireless IEM 18  OCARINA UHF Theta 98 Mix 18 Anna Ears L Wireless IEM 19  SAX UHF Theta 98 Mix 19 Anna Ears R Wireless IEM 20  ACC GTR BSS DI Y Mix 20 Sax Ears L Wireless IEM 21  GTR TOP BT 4051 * Y Mix 21 Sax Ears R Wireless IEM 22  GTR BOTT MD422 Mix 22 DDL 1 FX 1 23  LINE 6 BSS DI Y Mix 23 Rev 2 FX 2 24  HARMONICA XLR Mix 24 Rev 3 FX 4 25  SIMON VOX UHF Theta 58d Matrix 1 Spare IEM Plus Spare Belt Pack = 2 packs 

26  SIMON VOX SPARE UHF Theta 58d Matrix 2 Spare IEM  27  BASS VOX Theta 57d Matrix 3  28 KEY VOX Theta 57d Matrix 4  29 GTR VOX Theta 57d Matrix 5  30 BV UHF Theta 58d Matrix 6  31 YAMAHA AN1x Active DI Y Matrix 7  32 YAMAHA FS1R Active DI Y Matrix 8  33 Motif ES Active DI Y Master L Wedge Cue L  34 YAMAHA CS6x L Active DI Y Master R Wedge Cue R  35 YAMAHA CS6x R Active DI Y Master L IEM Cue L  36 VL1 L Active DI Y Master R IEM Cue R  
 

37 VL1 R Active DI Y
 

 
38  SEQ 1 - LOOPS XLR
39  SEQ 2 - LOOPS XLR
40  SEQ 3 - BASS XLR
41  SEQ 4 - FX XLR
42  SEQ 5 - KEY 1L XLR
43  SEQ 6 - KEY 1R XLR
44  SEQ 7 - KEY 2L XLR
45 SEQ 8 - KEY 2R XLR
46  SEQ 9 - VOX XLR
47  SEQ 10 - VOX XLR
48  SEQ 11 - GUIDE XLR
49  SEQ 12 - CLICK XLR
50  KEY TALKBACK MXL 58mic51  AMBIENCE SR  A415 Y52  AMBIENCE SL  A415 Y53 Talk to Stage MXL58 switch54 CD
55 CD
56 DDL Simon
57 DDL Simon
58 Rev Simon
59 Rev Simon
60 Rev Sax
61 Rev Sax
62 Rev Kit
63 Rev Kit
64

PM5D 设置：流程指南。  
在指南的第1部分，我们对如何将PM5D设置为用于特定大监听设置的监听桌面作了流程介绍。在本部分，我们

将使用相同的附加信息设置相同演出，但使用PM5D Editor而非调音台。该技巧同样适用于FOH或广播设置。

PM5D 附件规格；

指定 PM5D 调音台时，建议您弄清所需的型号；PM5D（手动前置放大器）或 PM5D-RH（可调用前置放大器）

及是否需要 DSP5D 和 DCU5D 以连接额外通道。同时指定您需要的最新调音台固件、任何 MY 卡、备用 PSU、

LA1L 台灯和运行 Studio Manager 的笔记本电脑所用的主电源。请始终用您自己的 PCMCIA 卡进行数据备份和

加载，并牢记使用 USB 电缆进行 Studio Manager 连接！

任何版本的调音台固件均可加载 PM5DV2 Editor 文件，但 Editor 软件版本必须兼容调音台固件版本。www.
yamahaproaudio.com 上始终有最新的版本可供下载且附带兼容性列表。但根据经验，最新的调音台版本始终会

接受相同版本和旧版本的 .PM5文件。仅在使用新版本的Editor为运行旧固件的调音台创建文件时才会发生问题。

雅马哈始终建议您使用最新版本的调音台固件以避免此类潜在问题，但如果无法做到，则使用 PM5D Editor V1
创建旧的 .PM5 文件。如果你希望联机使用，则需要并发版本。如果需要，可在合适的 PCMCIA 卡上携带当前

的调音台固件并作好调音台更新准备。
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输入名称并进行转接；计划阶段。  
当使用 PM5DV2 Editor 准备演出文件时，请务必牢记实际调音台台面的布局和配对 / 立体声通道的使用限制。

某些需要牢记的要点；

1) 非立体声通道可配对产生立体声，但仅限于邻近的奇 / 偶通道。

2) 各非立体声层中有 24 个通道，两层中有 4 个立体声通道，因此避免对相关通道进行跨层分组。（正如跨中央

- 主模拟调音台拆分相关通道一样。）

“示例”中的通道数要求小于 64 且许多是立体声通道，所以它们可装于单个 PM5D 上。

最明显立体声通道候选者就是效果返回、CD 和环境麦克风。需要多设一个立体声通道；这可能是一个立体声

键盘或立体声采样线路；但在本例中选择了鼓声顶置麦克风。

这显示在此处修订列表的“First Attempt”栏中。

Input Channel List for THE EXAMPLES As; August 2006

First Second 
Attempt! Attempt!

Multicore PM5D PM5D
Ch Ch Ch Channel 4Nam! Mic +48V

1 1 1  KICK B52 K 52 SH 53 

2 2 2  KICK 91 K91 SH 92 Y

3 3 3  SNARE TOP SNtp SH 57 

4 4 4  SNARE IN SNin XLR Y

5 5 5  SNARE BOTT SNbt KP 85 Y

6 6 6  TIMBALE Timb Theta 98 

7 7 7  HI HAT Hats A 452 * Y

8 8 8  TOM 1 Tom1 Theta 98 Y

9 9 9  TOM 2 Tom2 Theta 98 Y

10 10 10  TOM 3 Tom3 Theta 98 Y

11 11 11  TOM 4 Tom4 Theta 98 Y

12 12 12  RIDE Ride A 461 Y

13 Stereo 1L Stereo 1L  OH SR  Ohsr A 415 Y

14 Stereo 1R Stereo 1R  OH SL Ohsl A 415 Y

15 13 13  SPD SPD Active DI Y

16 14 14  BASS PRE Bss1 Active DI Y

17 15 15  BASS POST Bss2 UHF Theta 98 

18 16 16  OCARINA Ocar UHF Theta 98 

19 17 17  SAX Sax UHF Theta 98 

20 18 18  ACC GTR Acou BSS DI Y

21 19 19  GTR TOP GtrT BT 4051 * Y

22 20 20  GTR BOTT GtrB MD422

23 21 21  LINE 6 Lin6 BSS DI Y

24 22 22  HARMONICA Harm XLR 

25 23 23  SIMON VOX Simo UHF Theta 58d 

26 24 24  SIMON VOX SPARE Sspr UHF Theta 58d 

27 25 25  BASS VOX John Theta 57d

28 26 26 KEY VOX Nick Theta 57d

29 27 27 GTR VOX Andy Theta 57d

30 28 28 BV Anna UHF Theta 58d 

31 29 29 YAMAHA AN1x AN1x Active DI Y

32 30 30 YAMAHA FS1R Voco Active DI Y

33 31 31 Motif ES Moti Active DI Y

34 32 32 YAMAHA CS6x L CS6L Active DI Y

35 33 33 YAMAHA CS6x R CS6R Active DI Y

36 34 34 VL1 L VL1L Active DI Y

37 35 35 VL1 R VL1R Active DI Y

38 36 >>37  SEQ 1 - LOOPS Loop XLR

39 37 38  SEQ 2 - LOOPS Loop XLR

40 38 39  SEQ 3 - BASS Bass XLR

41 39 40  SEQ 4 - FX FX XLR

42 40 41  SEQ 5 - KEY 1L Key1 XLR

43 41 42  SEQ 6 - KEY 1R Key1 XLR

44 42 43  SEQ 7 - KEY 2L Key2 XLR

45 43 44 SEQ 8 - KEY 2R Key2 XLR

46 44 45  SEQ 9 - VOX Vox XLR

47 45 46  SEQ 10 - VOX Vox XLR

48 46 47  SEQ 11 - GUIDE Gide XLR

49 47 48  SEQ 12 - CLICK Clik XLR

50 48 36  KEY TALKBACK KeyT MXL 58mic

51 Stereo 2L Stereo 2L  AMBIENCE SR Ambi  A415 Y

52 Stereo 2R Stereo 2R  AMBIENCE SL Ambi  A415 Y

53 FX 4L FX 4L Talk to Stage TTS MXL58 switch

54 FX 3L FX 3L CD CD L

55 FX 3R FX 3R CD CD R

56 Stereo 3L Stereo 3L DDL Simon DDL

57 Stereo 3R Stereo 3R DDL Simon DDL

58 Stereo 4L Stereo 4L Rev Simon RevS

59 Stereo 4R Stereo 4R Rev Simon RevS

60 FX 1L FX 1L Rev Sax Rsax

61 FX 1R FX 1R Rev Sax Rsax

在此阶段，注意到立体声采样线路为偶 + 奇配对，因

此无法将它们成对链接。决定移动一个单通道后，可

进行配对；这标示为第二次尝试。

在“示例”中，选择将Simon语音保留为一层的最后通道；

使它能被快速找到。
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输入名称并进行转接；
在Editor中，可在转接窗口或主INPUT CH窗口中输入通道名称。INPUT CH窗口中的Tab键可用来将光标移至下

一名称，因此最便于快速命名。双击名称使其高亮显示，然后键入新名称。当然，名称仅限于使用四个字符，

但不要忘记上下移动抑扬键^和v以及左/右箭头键（<>）等有用的键，使用Tab键可移至下一名称。

改变转接；

Input Channel List for THE EXAMPLES 
As; August 2006

First Second Attempt! Attempt!Multicore PM5D PM5DCh Ch Ch Channel
4Nam! Mic

+48V

1 1 1  KICK B52 
K 52 SH 53 

2 2 2  KICK 91 
K91 SH 92

Y

3 3 3  SNARE TOP SNtp SH 57 

4 4 4  SNARE IN SNin XLR
Y

5 5 5  SNARE BOTT SNbt KP 85
Y

6 6 6  TIMBALE 
Timb Theta 98 

7 7 7  HI HAT 
Hats A 452 * Y

8 8 8  TOM 1 
Tom1 Theta 98 Y

9 9 9  TOM 2 
Tom2 Theta 98 Y

10 10 10  TOM 3 
Tom3 Theta 98 Y

11 11 11  TOM 4 
Tom4 Theta 98 Y

12 12 12  RIDE 
Ride A 461

Y

13 Stereo 1L Stereo 1L  OH SR  
Ohsr A 415

Y

14 Stereo 1R Stereo 1R  OH SL 
Ohsl A 415

Y

15 13 13  SPD 
SPD Active DI Y

16 14 14  BASS PRE Bss1 Active DI Y

17 15 15  BASS POST Bss2 UHF Theta 98 

18 16 16  OCARINA 
Ocar UHF Theta 98 

19 17 17  SAX 
Sax UHF Theta 98 

20 18 18  ACC GTR 
Acou BSS DI Y

21 19 19  GTR TOP 
GtrT BT 4051 * Y

22 20 20  GTR BOTT GtrB MD422

23 21 21  LINE 6 
Lin6 BSS DI Y

24 22 22  HARMONICA Harm XLR 

25 23 23  SIMON VOX Simo UHF Theta 58d 

26 24 24  SIMON VOX SPARE Sspr UHF Theta 58d 

27 25 25  BASS VOX John Theta 57d

28 26 26 KEY VOX 
Nick Theta 57d

29 27 27 GTR VOX 
Andy Theta 57d

30 28 28 BV 
Anna UHF Theta 58d 

31 29 29 YAMAHA AN1x AN1x Active DI Y

32 30 30 YAMAHA FS1R Voco Active DI Y

33 31 31 Motif ES
Moti Active DI Y

34 32 32 YAMAHA CS6x L CS6L Active DI Y

35 33 33 YAMAHA CS6x R CS6R Active DI Y

36 34 34 VL1 L
VL1L Active DI Y

37 35 35 VL1 R
VL1R Active DI Y

38 36 >>37  SEQ 1 - LOOPS Loop XLR
39 37 38  SEQ 2 - LOOPS Loop XLR

40 38 39  SEQ 3 - BASS Bass XLR

41 39 40  SEQ 4 - FX FX XLR

42 40 41  SEQ 5 - KEY 1L Key1 XLR

43 41 42  SEQ 6 - KEY 1R Key1 XLR

44 42 43  SEQ 7 - KEY 2L Key2 XLR

45 43 44 SEQ 8 - KEY 2R Key2 XLR

46 44 45  SEQ 9 - VOX Vox XLR

47 45 46  SEQ 10 - VOX Vox XLR

48 46 47  SEQ 11 - GUIDE Gide XLR

49 47 48  SEQ 12 - CLICK Clik XLR
50 48 36  KEY TALKBACK KeyT MXL 58mic

51 Stereo 2L Stereo 2L  AMBIENCE SR Ambi  A415
Y

52 Stereo 2R Stereo 2R  AMBIENCE SL Ambi  A415
Y

53 FX 4L FX 4L Talk to Stage TTS MXL58 switch

54 FX 3L FX 3L CD
CD L

55 FX 3R FX 3R CD
CD R

56 Stereo 3L Stereo 3L DDL Simon
DDL

57 Stereo 3R Stereo 3R DDL Simon
DDL

58 Stereo 4L Stereo 4L Rev Simon
RevS

59 Stereo 4R Stereo 4R Rev Simon
RevS

60 FX 1L FX 1L Rev Sax
Rsax

61 FX 1R FX 1R Rev Sax
Rsax

62 FX 2L FX 2L Rev Kit
R sn

63 FX 2R FX 2R Rev Kit
R sn

64

PM5D的一大强项就是具备标准默认转接，无需对简单演出进行转接。但是，示例是一个带有许多立体声通道

的长而复杂的输入列表，所以某些转接会很有用。

可通过改写通道列表实现转接，亦可通过移动调音台

背面的 XLR 接口实现模拟型转接。但是为了避免此类

物理转接使使用调音台的任何其他技师产生混淆，为

了与 FOH 和任意其他录制或广播调音台保持一致，最

好使用内部“软转接”。

蓝色斑点表示台面通道（左列）和输入插口（顶行）

之间的连接。默认转接为 1 到 1。

更改转接；

只需点击蓝色斑点即可添加或删除连接。

可在WINDOWS>UTILITY > PREFERENCES中禁用

确认弹出窗口。一个输入插口可转接至多个通道（叉

分），但多个输入无法馈给一个通道。（这就是需要

调音台的原因！）

使用转接以确保您的通道处于方便的位置；即立体声

通道处于奇-偶位置且一般通道处于不同层的相关组

中。

Name>Tab>Name>Tab>etc
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将非立体声输入通道配对成立体声；

在调音台工作面上，可按下并按住两个[SEL]按钮进行

配对，但在Editor中，必须使用Selected Channel窗口。

点击  心形图标制作配对（立体声）通道。除相

移和HA之外的所有参数均被链接。要使HA配对或成

组，可使用HA控制旋钮旁的[Gang]按钮。如果需要，

HA结合成组时可带有偏移。

施加 +48V 电压至输入端口。

常规的 PM5D 机型上，+48V 开关位于模拟增益钮的

上方，但在 PM5D-RH 机型上，+48V 由软件控制，因

而可在 Editor 中进行设置。

在选择通道中或 INPUT CH 窗口中，24 条通道中的每

一条都有一个 +48V 开关。

输出转接。

主输出（立体声 A、B、CUE、MONITOR、MATRIX 1-8）在背面有专用输出 XLR，但也可将它们转接至 MY 插槽，

甚至转接到 24 混音输出插口区。24 混音输出默认转接至 24 混音输出插口，但如果需要数字或模拟格式的输出，

也可将它们转接至 MY 插槽。我们将另外探讨 FX 转接。

Output channel list for THE EXAMPLES

As; August 2006

Mix Description Notes

Mix 1 SF SR TOP + SUB

Mix 2 SF SL TOP + SUB

Mix 3 Bass Out Wedges

Mix 4 Bass In Wedges

Mix 5 GTR Out Wedges

Mix 6 GTR In Wedges

Mix 7 Drum Wedge Wedge

Mix 8 Drum Sub Dual 15" Pwr Sub

Mix 9 Drum Rev FX 3

Mix 10 Key Wedge L Wedges

Mix 11 Key Wedge R Wedges

Mix 12 Nick Ears L Wireless IEM Plus Extra Belt pack for Keys Tech

Mix 13 Nick Ears R Wireless IEM Plus Spare Pack = 3 packs

Mix 14 Drum Ears L Wired Ears Plus Spare Belt Pack = 2 packs

Mix 15 Drum Ears R Wired Ears

Mix 16 Simon Ears L Wireless IEM Plus Spare Belt Pack = 2 packs

Mix 17 Simon Ears R Wireless IEM

Mix 18 Anna Ears L Wireless IEM

Mix 19 Anna Ears R Wireless IEM

Y Mix 20 Sax Ears L Wireless IEM

Y Mix 21 Sax Ears R Wireless IEM

Mix 22 DDL  1 FX 1

Y Mix 23 Rev 2 FX 2

Mix 24 Rev 3 FX 4

Martix 1 Spare IEM
Plus Spare Belt Pack = 2 packs

Matrix 2 Spare IEM

Martix 2
Matrix 3
Martix 3
Matrix 4

Y Martix 4

Y Matrix 5

Y Martix 5

Y Matrix 6

Y Martix 6

Y Matrix 7

Y Martix 7
Matrix 8
Master L
Master R
Master L
Master R

计划您的输出；

仅可链接奇 / 偶配对进行立体声混音，因此如果您使

用立体声输出，请相应地规划混音设置。

可使用台面背后插口中的 XLR 进行模拟型转接，但

如果使用 MY 输出卡（例如 MY16-AE）输出至放大

器上的 AES/EBU 输入口，则必须使用输出转接。

“示例”系统要求 IEM 和 DSP 放大器连接模拟输入，

因此输出转接可保留为一对一。
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将输出混音配对成立体声；

在调音台工作台表面上，可按下并按住两个[SEL]按钮

进行配对，但在Editor中，必须使用Selected Channel窗
口。点击  心形图标制作配对（立体声）通道。

除相移之外的所有参数均被链接。请牢记需要对相移

进行设置；您可在Selected Channel窗口或MIX窗口中

进行此操作。

输出命名 ;

在Editor中，可在转接窗口或主MIX、MATRIX或

STEREO通道窗口中输入输出混音名称。通道窗口中

的Tab键可用来将光标移至下一名称，因此最便于快速

命名。双击名称使其高亮显示，然后键入名称。输出

名称在Editor中非常有用且出现在调音台的相关屏幕

中。当使用可分配衰减器时，输出名称仅出现在面板

表面上。

如果您希望大致对FOH设置混音，可简单地将输入衰

减器拖至相应电平，但对于监听没有Fader Flip或Sends 
on Fader型模式。最简单的方法是使用SEL通道窗口并

拖转旋钮设置电平。在此初期阶段该过程几乎是没有

意义的，反而会比将各值保留为零导致更多问题，但

之后，这会是试音和首演后进行调整的方法。

这也是通过平板式控制器调整混音发送的最精确方

法。

设置混音电平。
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现在是储存场景并保存设置工作的好时机。

完成命名和转接后，是对您的设置进行首次保存的好

时机。下面我们将在存储卡上将数据保存为调音台文

件，但首先应储存迄今作为该文件中的场景所完成的

设置。

请牢记雅马哈使用术语“储存”创建场景记忆而使

用“保存”创建整个调音台和其他设置记忆。

打开SCENE窗口并选择场景位置，然后按下

[STORE]。
储存过程中不会提示您添加名称，但您可通过双击

[Initial data]名称区域进行此操作。

.PM5D格式

.PM5文件可通过PM5D调音台和PM5DV2 Edtior打
开，.YSE文件仅可通过编辑器打开。

如果您在设置仅一部PM5D调音台的最简单系统，始

终使用Editor File>Save菜单保存为.PM5文件是明智

的。

.YSE格式

其他格式提供某些优势。一个小便利就是.YSE文件能

以储存时相同的窗口布局打开，因此能更快地开展工

作。.YSE文件格式也是.YSM (Yamaha Studio Man-
ager)文件的必要组成部分。

 
Editor:  File> Save As> .PM5

确切的保存方法取决于您使用Windows还是Mac计算机，但常规步骤应大致相同。转到File>Save。首次保存时

会有对话框要求您命名文件并选择保存目的地。选择像“示例演出”之类的名称，并保存在您系统的文件夹

中。可以两种格式保存数据；.PM5文件或.YSE文件(Yamaha Studio Editor)。

储存场景

保存会话

如果您不将设置储存为带编号的用户场景，还可将其保存至存储卡中，以后可作为当前场景加载。但是，如果

未进行储存，则无法将其作为独立场景载入另一会话文件中，要记住如果作为当前场景加载数据，极易被意外

更改且无法返回至任何场景，因此将其储存为场景是非常明智的。
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Manager; File >SaveAs>. YSM

.YSM格式

如果您拥有PM5D和DSP5D或其他多装置系统，保存

为.YSM文件可能会使数据管理更为方便，因为这将

在一个存储器中保存两部“调音台”。但是，请牢记

如果要通过存储卡加载，则必须将此数据转换为两

个.PM5文件。如果.YSM文件在与DSP5D和PM5D联机

连接的Studio Manager中打开，则可同时与两部调音台

同步，比存储卡加载速度更快。.YSM文件也会记录

窗口布局，因此便于编辑。还可用Steinberg Cubase会
话通过链接打开.YSM文件。这些都是.YSM文件的优

势。

若要保存为.YSM文件，可通过包含Editor图标的Studio 
Manager窗口使用File>Save菜单。

内部效果引擎。

PM5D 共有八个内部效果引擎；各引擎均可用作立体声输入 / 输出 SPX 2000 型多效果装置。所有效果程序和参

数都可使用 Editor 进行预选并保存至调音台文件中。

转接内部效果；

可从Input Patch Editor和Output Patch Editor窗口对效果

引擎的输入和输出进行转接，但通过Effect Editor窗口

本身查看效果转接更为方便。

可将效果作为发送和返回型(Mix out>Effect>Channel 
in)进行转接或插入。插入选项对于附加压缩器非常

有用，但是“示例”技师在萨克斯管通道中插入了

混响；这将保存有价值的混音发送，并通过Wet/Dry 
Mix Balance控制完成萨克斯管效果的平衡。共有两个

Effect Editor窗口；第一个窗口Effect Editor可用于改变

所有参数和访问效果预设的资料库。第二个窗口Effect 
Editor [Locked]可用于更改参数但无法更改主资料库预

设。可从各窗口访问所有八个引擎。

点击Effect Editor窗口中的[Library]，改变默认的Large 
Hall混响效果。
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用于附加效果的加强型GUI（图形用户界面）。

在资料库位置46至54的效果是一个特殊的“附加”效果系列，它们在Editor中有特殊控制GUI页面。在调音台屏

幕上没有这些GUI，但那些效果显然能在调音台中运行，只不过通过更简单的GUI。Rev-X GUI特别有助于理解

混响参数。

Rev-X

EQ 601

Comp276

Comp260Opendeck
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矩阵。
PM5D矩阵具有8个输出并由24条混音总线和2条立体声主总线馈给。您可对各矩阵进行类似混音的配对。

Matrix窗口显示了主输出电平衰

减器，并条形显示馈给矩阵通道

的24条混音总线和2个立体声表

的电平。可从此窗口横拖显示

条，但如果没有超大屏幕则会很

麻烦。

为了进行更精确的电平设置，请

使用Selected Channel窗口。

“示例”将矩阵用于备用入耳式监听系统；

如果乐队成员的 IEM 系统存在故障，可将他们的混音发送至备用系统；

1) 打开 MATRIX 1 和 2，按住 SEL 通道窗口中的心形符号对它们进行配对。

2) 点击并拖转旋钮图像将矩阵发送切换至 [ON] 并调至额定值。

3) 如果矩阵输出连接有备用 IEM 组件，则可供任意 IEM 用户在其自身系统发生故障时使用。快速双击故障组

件的混音 SEL 键并使用矩阵编码器（或使用联机的 Studio Manager）将混音接通矩阵，即可在备用组件中

使用混音。

图形均衡器，GEQ。
PM5D 具有 12 个专用的内部图形均衡器，利用 FX 设备可再添加 8 个。这些均衡器为 31 频带 1/3 八音度 GEQ，

可选择减弱 / 增强深度并对通过音频进行频谱分析。PM5D 上无法使用 Flex-15 型 GEQ。GEQ 可插入任意的输

入或输出通道。可在 Studio Manager 中进行 GEQ 的转接和设置。 

若要操作或转接GEQ，请打开GEQ Editor窗口。共有

两个视图可用，两个均可包含所有GEQ。若要转接

GEQ，点击[NONE]并选择要将设备插入的通道。

插入GEQ后会自动打开通道插入点。但请注意，

GEQ并未打开（处于旁通状态）。
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用户自定义键。

PM5D 面板上共有 25 个用户自定义键；其中 24 个在同一区域而另一个在 DCA 衰减器部分上方。共有四个按

键集 (ABCD)。所有键均可进行各种用户所选任务的编程；最常用的是“书签”或屏幕快捷键、“下一或上一场

景”以及延迟型效果发送的“节拍”。“示例”技师对其每位主要艺术家使用“Layer Snapshot”用户自定义键

以快速访问他们的监听混音。可在 PM5DV2 Editor 中进行此类编程。可在 Editor 中对各键进行编程，但即使是

联机时也无法通过 Editor 进行操作。

要开始对UDK进行编程，请打开User Defi ned Keys 
Setup窗口。通过Windows下拉列表中的Utilities进入此

窗口。

按下UDK图像以打开Parameter窗口，犹如在PM5D面

板上操作一样选择UDK功能。

当编辑器与PM5D联机连接时，可使用具有“PM5D 
Editor Control”功能的UDK在编辑器上调出各种屏

幕。它们与联机编辑器的书签类似。

当您对UDK完成编程时，请在纸上记下您的选择，因

为在加载文件时需要用胶带和笔对PM5D面板进行标

示。UDK部分没有电子命名功能。

可分配 /DCA 衰减器。

八个可分配衰减器都具有多种功能；它们可以是 DCA 主控制或可分配任意用户自定义衰减器功能。共有 6 个

用户分配集和专用 DCA 集。可在 Editor 中对可分配衰减器进行编程。

点击某一字母集的任一通道，将会打开所有通道的菜

单。因为可从附带两个DSP5D系统的PM5D中选择通

道，所以菜单非常大，但对于简单的PM5D设置，可

使用无#键编号的通道。使用[STAY]选项将衰减器固

定为其最后分配的功能，或使用[----]禁用衰减器。
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监听技师用衰减器上的提示电平；
PM5D 的监听音量由旋转钮控制，但舞台监听技师通常希望用衰减器控制。在 2007 年夏季的第 2 版软件上市

之前，这仅可通过某些间接通路方法实现，这在先前指南中已作说明。新的 V2 固件采用了直接方法。可在

Fader Mode Assign 窗口使用屏幕右下方的两个分配框进行操作。“示例”技师使用立体声 A 和立体声 B 衰减器

控制提示和监听总线。选择 A 将提示输出提供至本地 IEM 组件，选择 B 将监听总线馈送给本地声楔。出于此

用途，可使用 PM5D 面板上的 [MONO] 键将监听总线混成非立体声，但这无法在 Editor 中编程。类似地，使

用面板旋转控制钮将监听和提示输出音量设为最大（额定输出）并取消选择粉色 [Stereo A feeds monitor bus] 键，

从而使监听总线作为提示总线的副本工作。

作为高级监听技师的用户仍可使用 Monitor Assign 键实现双重监听总线，可同时听到声楔和 IEM 组件的不同混

音。

再次储存和保存。

现在是再次储存场景并保存到计算机的存储器中的好时机。更多详情请参阅本手册的第 14 页。

请牢记在您保存文件时，选择 .PM5 作为文件类型。从而使该记忆既能保存至 PC 卡又能直接载入调音台。

如果您按照流程操作，应该发现下列所有项目均已就绪，

可载入调音台；

1) 已命名和转接的输入

2) 幻象设置

3) 已命名和转接的输出

4) 已转接的效果

5) 已命名和转接的矩阵

6) 已转接的 GEQ
7) 已编程的用户自定义键

8) 已分配的可分配衰减器

9) 监听衰减器（如果需要）

10) 将所有这些储存为开始场景 适用的存储卡为 PCMCIA 卡或带专用适配器的紧凑型

闪存 (CF)。雅马哈仅推荐并支持 FAT16 格式的卡，大

部分容量为 2 GB 的卡足以进行文件传送工作。

现已创建会话并保存至计算机的存储器，您需要考虑

如何将此传送至PM5D。

有两种选择；

1) 将数据保存至PC型存储卡并转移至PM5D
2) 联机连接Studio Manager并将编辑器与调音台同步。



PM5D/PM5D-RH 快速启动指南 第 3 部分

23

从PCMCIA卡加载PM5D数据。（基本加载所有数据）；

通过 DISPLAY ACCESS>UTILITY>>LOAD 访问 LOAD 屏幕。

在将数据载入 PM5D 之前，请确保对调音台内的数据进行备份或不再需要。

警告！！以这种方法加载数据会改写所有现存的调音台数据。*
加载页面会显示一个由存储卡上保存的所有内容（甚至是非 PM5D 相关的内容）组成的列表。滚动到您的 .PM5
文件，点击 [LOAD] 和任何确认对话框。您的数据将被载入调音台而调音台内的任何数据都将丢失。*（如果使

用输出隔离功能，则可保留输出数据）。

除LOAD之外；

调音台会按照您在 Studio Manager 中的指示设置。只

有监听部分的旋转钮、常规 PM5D 上的 HA 部分和

PM5D-RH 背面的 +48V MASTER 开关可能不同。

你在此阶段可能希望将一些标示胶带贴到用户自定义

键区域和混音主控制上。

现在可进行首次试音和演出。在进行时储存场景。如果您不确定何时储存，则请经常进行储存；您总可在稍后

删除场景。

指南的第 2 部分提供了有关使用 PCMCIA 卡进行保存和加载的更多信息，以及如何编辑场景和管理调用选项。
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首次开始联机；Studio Manager、PM5DV2 Editor和PM5D。
如果您已脱机使用Studio Manager和PM5D Editor，则只需添加USB连接电缆和USB-MIDI驱动程序即可进行联

机。可从www.yamahaproaudio.com下载PC和Mac的当前驱动程序。通过查看PC的控制面板或Mac的系统偏好

设置检查USB驱动程序是否已安装。无需点击驱动程序，连接PM5D会将其激活。如果您点击它，只会打开

一个对话框提示未连接任何调音台。对于DSP5D，需要安装DME-N network Driver。DSP5D的默认IP地址为

192.168.0.129。

下载驱动程序后，按指导说明解压缩并安装驱动程序。在PC连接PM5D的情况下，会弹出“发现新硬件”向导

并帮助您安装驱动程序，方法与连接新的USB打印机或其他办公外围设备完全相同。使用Mac的情况下，只需

双击图标并按照加载说明操作。下载站点中有两个操作系统的完整指导说明可供参考。

使用Windows XP的情况下，驱动程序会与特定的USB端口相关联，如果使用不同的端口则需重新安装驱动程

序，因此建议始终用相同的USB端口进行连接，但是Vista和Mac计算机没有此限制。

PM5D调音台设置

需要在调音台表面选择希望Studio Manager信号通过

哪个端口进行控制。按下显示访问部分中的MIDI/
REMOTE键并按住直至出现MIDI Setup标签。在屏幕

的右下角可看见PM5DV2 EDITOR框。选择USB并让

其他框继续显示1-1。

现在已准备好与PM5D进行联机。如果Studio Manager已打开，请保存您的工作，将其关闭然后重新打开。

Studio Manager仅在打开时搜索调音台，因此如果您在程序打开后连接电缆，则不会进入联机状态。同样，如果

您在联机状态下断开电缆并重新连接，则不会恢复联机状态。
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首次开始联机时设置MIDI端口。

设置通信分多个阶段，但在各阶段，如果您设为“默认”，则无需在下次连接时再次设置这些内容。从PC的开

始菜单或Mac的任务栏打开Studio Manager。这时不要打开编辑器。

当您打开Studio Manager时，会显示Editor图标

屏幕。不要双击图标进入编辑器，点击PC上的

FILE>>>SETUP或Mac上的SM2>>>Preferences。
选择MIDI Settings标签。如果MIDI驱动程序安装正

确，则应该有8个端口的选项，多个端口允许进行更

为复杂的设置。输入和输出端口都选择端口0-1。确认

选中了Set Default选项并点击OK。DSP5D仅有一个端

口，标示为Unit 1或您在DME-N网络驱动程序中命名

的名称。

现在可双击打开Editor窗口。下一步是将Editor分配

至那些MIDI端口。点击FILE>>SYSTEM SETUP并从

下拉框中选择端口。请牢记要选中Set Default并点击

OK确认。

现在您的计算机应该已与PM5D联机。Editor屏幕上并未对此有明显的指示。若要检查是否处于联机状态，只需

拖动屏幕衰减器并观察PM5D衰减器是否移动！但如果有人正在使用台面，则可打开Sync窗口进行检查。点击

Windows和Sync或使用快捷键Ctrl+1。在此阶段，请务必理解系统中可能存在的连接状态。联机、脱机和同步。

因此，应该明白分配MIDI端口分两

个阶段。首先在Studio Manager中分

配所有端口，其次将所用的各Edi-
tor分配至所选端口之一。如果只有

一台调音台，这似乎复杂化了，但

这对于大型设置很有必要。
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处于联机连接状态时，表示PM5D或PC上使用的任意

控制器将控制参数并将其设为选定值。如果将带新设

置的Studio Manager连接至经过初始化的PM5D，两者

也会进行相应的同步使PM5D上显示的值与PC上显示

的值一致。但是，如果您连接至正在使用的PM5D，

则PC和PM5D不会显示相同的参数；两者联机但并未

同步。若要进行同步，您可点击SYNC窗口中的RE-
SYNC按钮，或进入窗口顶部的Synchronization并选择

Re-Synchronize。

两种方法均会在屏幕上打开Synchronize窗口。此窗口

用于选择同步方向。这极为重要，再夸张也不为过！

如果您从PC向调音台同步，则调音台的所有设置都会

调整为与PC相同的设置，且调音台设置都会丢失。

联机、脱机和同步。

您可能回忆起PM5D快速启动指南第2部分和从存储

卡加载部分中的说明；PM5D内仅有一个调音台存储

器，因此如果同步改变了所有数值，则所有现存数值

均会丢失。如果您不希望丢失这些设置，请保存至

PCMCIA卡或同步至PC并在您的计算机中保存该会

话。这就是为何选择同步方向如此重要的原因。

如果无法实现同步或无法完成同步，请检查您是否拥

有版本兼容的Editor和调音台固件。www.yamahaproau-
dio.com/downloads

不使用PCMCIA卡加载和保存会话：使用Studio Manager。

不使用存储卡将数据载入PM5D；

1. 进入联机状态，

2. 在Studio Manager中打开会话，

3. 同步，PC至调音台。（所有的调音台数据均会丢失！！）

不使用存储卡从PM5D保存数据；

1. 用Studio Manager进行联机，

2. 同步，调音台至PC。
3. 点击File>>Save session as。
4. 选择用于保存数据的格式；.PM5文件或.YSE文件（相关说明请参阅第14页），选择计算机的某个位置并保

存。

至此，我们了解了如何使用PM5DV2 Editor代替用PM5D本身直接进行设置的过程。然后通过使用联机连接进行

加载，我们无需使用PCMCIA卡。在余下的部分，我们将深入探讨加载功能。

所有资料库同步。
当勾选Synchronize窗口中的[All Libs]时，会在同步期间复制调音台和PC之间的整个会话记忆，但如果不勾选

[All Libs]，则只同步当前场景。如果仅希望进行联机以远程控制调音台，因为数据量较少这样会更快更适用。

在大部分正常情况下，可保留[Fast Sync]勾选以获得最快同步速度。
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使用联机连接进行高级加载和保存。
在前一部分中，我们了解到可通过同步“PC至调音

台”模拟PC卡的加载操作。在本部分，我们探讨不使

用同步进行数据加载。这是意义非常重大的过程，因

为可在不中断当前调音台使用的情况下加载场景和设

置。更明白地说，我们可以在别人正在对演出进行实

况混音时将场景和其他数据载入调音台。

调音台或会话文件由什么组成？
在本指南第 2 部，我们了解到会话由整个资料库组组成。使用 PM5DV2 Editor 可从会话中提取这些资料库并将

它单独载入调音台。为了使系统更加灵活，可从资料库中提取单个记忆（如单个场景）并将它载入调音台，而

如果调音台存储器中的相应位置正在被使用，则可在加载时更改场景编号。下面回顾一下资料库；

蓝色框中包含使用调音台[Store]键储存场景时储存

的所有项目。它们可链接以便储存和调用。可独立

保存场景。

绿色框中混含只读和用户储存设置，用户内容是在

输入时储存的。

黄色框中的内容在创建时保存的，且每个调音台或

会话文件只储存一个版本。 红色框为由资料库组成的整个会话。

场景资料库
（500个用户记忆）

HA增益资料库
（199个用户记忆）

输入转接资料库
（99个用户记忆）

输出转接资料库
（99个用户存储
器）

调音台或会话文件
图形EQ资料库

效果资料库

组件资料库

选通门设置

输出通道资料库

输入EQ资料库

输入通道资料库

输出EQ资料库

MIDI配置 常规首选项和设置
（包括Recall Safe）

用户自定义键设置
（4个集）

事件列表存储器。

DCA衰减器模式。

A至F的6个设置

当前场景
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示例；将储存的用户效果从某一会话加载到另一会话。

在本例中，让我们想象歌手“Guest”在舞台上加入“The Examples”。“Guest”需要特殊的延迟效果转接以适

合他的嗓音。特殊效果参数保存在不同的PM5D文件中。有两种方法进行传送；

1. 手动。打开Studio Manager和PM5DV2 Editor并查看“Guests”演出文件中的参数。然后将它们手动复制并储

存到“The Examples”的演出文件中。如果仅一种效果，则可接受这种方法，但如果Guest要以不同效果演唱多

首歌曲，则这种方法会令人厌倦且容易出错。

2. 使用PM5DV2 Editor进行横向拖动。

在将Guest Delay FX从某一文件传送至另一文件之前，

必须将它储存在效果资料库中。使用PM5DV2 Editor，
打开带该效果的场景，再打开Effect Editor窗口并将该

效果储存至资料库。（Guest的技师可能已完成此操

作。）

接着，将所储存的效果从右手栏(INTERNAL DATA)拖
放到左手栏(FILE)中，然后确认。无法选择小于056的
资料库位置，因为这些是用于雅马哈预设的ROM。

点击FILE栏上方的SAVE按钮保存新用户资料库。这会

将资料库作为.PM5文件保存至您的计算机。但是，请

务必明白这并非PM5D会话文件，而只是一个效果资

料库。为此，建议您将资料库命名为能够反映其内容

的名称，因为如果不这么做会很容易与其他.PM5文件

混淆。在本例中，我们选择“GuestFX”。

如果您将此文件存放在PCMCIA卡中，则可将它高级

载入PM5D调音台，务必小心限制资料库条目的范围

并使目标指向空位置。

但也可不用调音台进行此操作。

关闭“Guest”会话并打开“The Examples”。打开

Effect Library窗口。

接着，使用FILE栏上方的Open按钮打开FILE侧
的“GuestFX”资料库。（可能自保存后仍然打开）。

将所储存的“Guest Delay FX”从FILE拖到INTERNAL 
DATA。选择一个空位置。

Library 窗口拖动功能。
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更多的 Library 窗口拖动功能。  
这一资料库窗口横向拖动项目的技巧也适用于其他资

料库项目。

值得注意的例外是用户自定义键资料库和SETUP资料

库。无法创建Bank B并将其拖入调音台或创建某些首

选项并将其拖入调音台。这些项目仅可通过同步输入

调音台，或从预备的PCMCIA卡加载到调音台。

除资料库项目外，也可按此方法拖动场景，但我们

应特别注意场景，因为通过链接Input Patch、Output 
Patch和HA资料库会使它们变得相当复杂。

场景的记忆结构
背景  PM5D场景记忆包含构成混音的大范围参数，如EQ、动态、电平、FX预设和参数、GEQ等。但必须明白

的是转接特别是通道命名并不储存在场景记忆内。HA值和+48V设置也分开储存在HA资料库中。输入转接和名

称储存在输入转接资料库，输出转接和名称储存在输出转接资料库。

因此要使调音台正确调用场景，不仅要有储存的场景数据，还要有HA资料库（仅限RH）、输入转接资料库和

输出转接资料库。由于技师仅有一个调用按钮，因此显然必须进行内部链接。当调用场景时，会通过这些链接

同时调用合适的资料库。

此操作在正常的调音台操作中会自动完成，但对场景和资料库进行高级加载时，有时需要重置这些链接。创建

场景时会将链接的资料库编号作为场景的一部分储存。

除从INTERNAL DATA拖到FILE并保存为资料库文件

外，另一种方法就是打开两个PM5DV2 Editor。这种方

法的优势是可同时打开两个会话并将数据从一个会话

横拖到另一会话，无需经历中间的保存阶段。当一个

编辑器与调音台联机而另一个脱机时，这种方法特别

有效。您可从脱机会话拖出并直接释放到调音台！请

特别注意不要使两个编辑器同时与调音台联机，并对

编辑器进行命名以免混淆！

使用两个 PM5DV2 Editor。
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在 PM5DV2 Editor 中建立和断开场景链接。

在PM5DV2 Editor的Scene窗口中，可拖动INTERNAL DATA部分使其大于FILE侧。现在可在所链接的HA、Input 
Patch和Output Patch资料库显示的同时查看场景名称和编号。

如果您从另一会话中拖入一个场景，它会携带某些资料库编号的链接。如果那些资料库位置中没有记忆，则调

用场景时会调用先前场景的资料库；不可能有不带任何资料库的场景！但是，因为通道名称位于转接资料库

中，所以事实上需要拖入相关的转接资料库并对编号发生改变的资料库重新建立链接。如果资料库编号相同，

则场景链接将会生效。

将两个乐队的场景合并入一个会话文件；
将场景从某一会话拖到另一会话（例如当两个乐队同台演出时合并两个乐队的会话）的过程为；

在Studio Manager中打开两个PM5DV2 Editor。（One和Two）
在一个编辑器内打开各乐队的会话。

在两个会话中打开Scene窗口并重新调整所有窗口的大小使您能够同时看到两个窗口。

将所需的场景从Editor One拖至Editor Two。选择空的场景位置（可能是新的编号）。

乐队Two的会话中现在有乐队One的场景，但没有通道名称、转接和HA值。

Drag and 
drop 

接着，在两个Editors中打开资料库窗口并选择Input 
Patch标签。

将资料库从One拖至Two并记录编号。

同样，拖动Output Patch资料库和HA资料库，记录

它们的新编号。

返回Scene窗口并从新加载的场景中将链接添加至

新加载的资料库，如本页顶部所示。现在调用场景

时会如同从乐队One会话中调用一样。

最后通过File>Save As保存此新的会话，重命名并

从.PM5或.YSE选择文件类型。

拖放
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此过程可在PC中完成而无需调音台，在演出之前，建议先练习此技巧。充分理解此过程后，即可准备在多乐队

或会演场合中使用，将场景和资料库从PC直接拖入调音台。

其限制是无法使用Studio Manager合并首选项和用户自定义键。首选项储存在SETUP资料库。无法对此进行横

向拖动，因此必须在所有场景中使用相同的首选项。技师们可通过PCMCIA卡（如果先前已通过调音台进行保

存）加载各自的SETUP资料库来接纳不同的首选项。（加载SETUP文件时务必考虑在Security页面锁定字时钟以

防Parameter Recall，否则可能会因调音台重新计时而导致某些音频无声。）

同样，无法将用户自定义键从某一会话拖到另一会话。但是，如果事先在高级加载模式中对用户自定义键进行

了保存，也可通过PCMCIA卡对它们进行高级加载。请在高级加载时更改集字母，使每位技师能拥有各自的用

户自定义键页面。使用用户自定义键或通过屏幕右下角的字母选择各集。

PM5D/PM5D-RH 快速启动指南分为三个部分。

非常感谢您读完这些指南。希望能有助于您获得PM5D系统的最佳性能。

对于快速启动指南这一称呼来说，本指南可能过冗长，但PM5D是一个非常全备的数字调音台。官方手册中包

含更多这些快捷指南所无的信息和章节。如使用用户自定义键生成GPI或MIDI命令以控制播放设备、照明或

AV设备等主题。时间代码和其他触发器（如MIDI）也可用于调用调音台内部场景，甚至操作衰减器和其他参

数。还有关于使用环绕声配置、GPI控制器的信息：输入与输出、时间代码和串联连接至其他调音台以及其他

更多需要学习的技巧！

PM5D 的无线远程控制。
USB电缆限制表示通过PC对PM5D进行远程控制的连接距离限制为5m。虽然可使用某些无线USB设备，但通常

不具备专业音频系统构建质量，或者不能进行长距离传输。因而我们建议使用带有无线接入点的PC连接调音

台，并通过无线VNC连接从另一PC远程控制此PC。此配置的设置超出了本文档的范围，但该配置日益受到欢

迎。通过平板PC可获得优良的控制能力，有些用户甚至尝试通过PDA或手机进行远程控制。

 

USB 
Wireless CAT5 

Viewer PC 

Server PC 

WAP 

服务器 无线

浏览器


